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Limitation on
Warranties and

Copyright

Version 21

If you discover physical defects in the media on which this software is
distributed, or in the manuals distributed with the software Manhattan
Graphics will replace the media or manuals at no charge to you, provided
you return the item to be replaced with prootf of purchase to Manhattan
Graphics or an authorized Manhattan Graphics dealer during the 20-day
period after you purchased the software In some countries the replacement

period may be different: check with your authorized Manhattan Graphics
dealer.

The program is provided “as is” without warranty of any kind. either
expressed or implied. including. but not limited to, warranties of
merchantability and fitness for a particular purpose The entire risk as to the
quality and performance of the program is with you. Should the program
prove defective you (and not Manhattan Graphics or an authorized dealer
of Manhattan Graphics software) assume the entire cost of all necessary
servicing. repair or correction

Manhattan Graphics does not warrant that the functions provided by this

program will meet your requirernents or that the operations of this program
will be uninterrupted or eror free

Manhattan Graphics does not make any warranty or representation, either
express or implied, with respect to the software described in this manual, its
quality, performance merchantability, or fithess for any particular purpose
As a result, this software is sold "as is.” the purchaser assurmes the entire risk
as lo its quality and performance

In no event will Manhattan Graphics be liable for direct, indirect. special
incidental. or consequential damages resulting fromn any defect in the
software or manual, even if they have been advised of the possibility of
such damages In par they shall have no liability for any programs or data
stored in or used with Manhattan Graphics products. including the costs of
recovering or reproducing these programs or data.

The warranty and remedies set forth above are exclusive and in lieu of all
others, oral or written, express or implied. No Manhattan Graphics dealer.
agent, or employee is authorized to make any modification, extension, or
addition to this warranty

some states do not allow the exclusion or limitation of implied warranties or
liability for incidental or consequential damages. so the above limitation or
exclusion may not apply to you. This warranty gives you specitic legal
rights, and you may also have other rights that vary from state to state

This manual and the software (computer programs) described in it are
copyrighted by Manhattan Graphics, with all rights reserved. Under the
copyright laws. this manual or the programs may not be copied. in whole
or part, without writteni consent of Manhattan Graphics. except in the
normal use of the software or o make a backup copy This exception does
not allow copies to be made for others, whether or not sold, but all of the
material purchased (with all backup copies) may be sold, given. or loaned

to another person. Under the law. copying includes translating into another
language or format.

You may use the software on any computer owned by you but extra copies
cannot be made for this purpose A multi-use license may be purchased to
allow the software to be used on more than one computer owned by the
purchaser, including a shared-disk system. (Contact Manhattan Graphics for
information on multi-use licenses.)

©1985, 1986 Manhattan Graphics Corporation
163 Varick Street
New York, New York 10013

ReadySetGo™ is a trademark of Manhattan Graphics Corporation.
Macintosh™, MacPaint™, and MacWrite™ are trademarks of Apple Computer, Inc

-
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How to Use
This Guide

Product
Support

Backups

This guide is designed to be a highly visual
introduction to ReadySetGo:

- Learning ReadySetGo is a step-by-step
tutorial and introduces all the basic features

- Using ReadySetGo shows in detail how a
number of page processing tasks are
accomplished.

- The Reference section contains a summary
of all the features of ReadySetGo.

If you are new to the Mac environment, an
excellent introduction is contained in the owner's
guide. Also, the MacPaint™ and MacWrite™ manuals

might be very useful to you

Product support is available from 1 pm to 5 pm
(Eastern Standard Time) Monday through Friday.
The telephone number is: 212-691-?2114. In order to use
our product support service you must be a
registered owner

The ReadySetGo disk is NOT copy protected. Before
you begin work use the Finder to make a backup
copy of ReadySetGo.



Learning ReadySetGo



To begin, insert the
ReadySetGo disk
into the disk drive
When the menu B SRR
bar and desktop ] | cetinfo %I
i . i Duplicate xD
icons appear, click o ot
the RSG21 icon and Page Setup e
choose Open from
the File menu. Now iy |_Elect ®E
click the
ReadySetGo 21
icon and choose 5
Open from the File R e e L

menu again.

Print Catalog

In a few seconds & File [dit Create Font Style Format HBHlock Page Special

the screen should 1] | ‘ 2 1 ‘ AR 1]_?
look like this. t | |

IEpIESEI’ltS the e VR NS, S VA e 7. R RS SRR S S i AR s R it #
upper left hand "
comer of the first
page of the
document.
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The page sizes
available are
determined by the
printer file
contained in the
system folder. To
examine the sizes
and orientations,
choose Page Setup

from the File menu.

If the system folder
contains the
ImageWriter file,
this dialog box
appears. US Letter
and Tall are the
default choices.
Change the
orientation to Tall
Adjusted and click
OK.

NOTE: Never use
the Tall orientation
with ReadySetGo.
Always use either
Tall Adjusted or
Wide.

F ; .
m Edit Create Font Style Formot Hiock Page Special i
New = 3N 2 | 3 ' 4 s 3 7
ﬂ_ Dpen 2D ! 1]
""" Close %I
‘ Save xS
............ SHHE H:_" I S S —— —— i e il
........ Prl“‘ BEE e TRrRRTCSNeaeney. REvenesrses [y ee— =1 FTSTPSSSTT Fra—.
et Teut I
2| | ouit =
£ Lok St Dot SR I LY Rl VI SR DR | VER
R S B B4
| 218

1

| _
Imagellriter (Standard or Wide)
@ US Letter

I Paper:
O US Legal

O A4 Letter

O International Fanfold

O Computer Paper

Orientation: OT

all

Q*‘rnli Adjusted

O Wide

gination: @ Normal pages O No breaks between pages

Ldit  Create Font Style Format Hlock Page Special

b

2 Reduction: ® None () 50 percent
i ] i
§ B Sl P TN IR e 5 R Bl il Wi o U i il I
| i
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|




Because the page
is larger than the
Macintosh screen,
only a portion of
the page is visible
at any given time.
Choose Show Page
from the Special
menu to see a
scaled-down
version of the
entire page.

Show Page is one
method used to
scroll around the
page The dotted
rectangle repre-
sents the portion of
the page which is
visible on the
screen. By dragging
this rectangle,
another part of the
page may be
brought into view.
Drag the dotted
rectangle to the
bottom right of the
page. Show Page
may be put away
by either clicking
in its go-away box
or choosing Close
from the File menu.

Format Hlock Page m :
| g 7
L. - Hide Grid

& File [dit Create Font Style
] oot ] ¥ 1 i
1] Zl e :
Rkl i el i 3ok e, (0T BLBLEY L 4T
| |
o1 i —r— i:_ e L S ——— ' .......................
| |
|
b3 md b it o v M S v ik, e AR
-i |
o/ "5 A b N ORI WY (e e s R
1} '
k i 1
r

& File Ldil Create Font th

Format  Hlock FPage

~|_Display Facing Pages

Send Behind
Display Page

Specinl

L

'l |

SO untitied Page | ﬁ'

1 Iq, 's [ l7
| o 1]
s
5 SN SHNS: S SNSCE WSSt S —
; ................. ! ....................................
mE o

Notice the inner rectangle drawn in the Show Page window
This rectangle is also superposed in real size on the page grid.
It indicates that part of the sheet of paper that the installed
printer can put an image on. Any text or graphic element (or
part thereof) placed outside this rectangle will not be printed.



The page has
scrolled to the
bottom right. Notice
from the grid that
the page is 1l
inches deep and
8% inches wide
(US. letter).

An alternative
(and faster)
method of scrolling
involves the use of
the Command key
and the mouse.
Think of the screen
as being divided
into the nine
squares of a tic-tac-
toe game. The
center square is
"dead” but helding
down the
Command key
AND clicking in
any of the other
eight squares will
scroll the page in
the direction
indicated. For
example, a
command/lick in
the upper left will
scroll the page up
and to the left. Use
this method to
scroll back to the
top left of the page.
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Create a second
page by choosing
Insert from the
Page menu. A new
page can be
created either
before or after the
current page. It can
be either a blank
page or a
duplicate of the
current page. Click
OK to create a
blank page two.

Return to page one
by choosing First
Page from the
Page menu

" & File [dit Create Font Style Format Hlack

Ty =

| |
11‘-

Insert After Current Page

Insert Before Current Page

Insert Blank Page

Duplicate Current Page

Cancel

Special

il e el b - b - S B ket Y R -

& File Edit Create Font Style Format I]Iu::kipm:lnl

|||||||||||||||
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Now begin to " & File tait Font Style Format Block Page Special )
create blocks on 1] ' 3 (N R C Y T T R
Frame

|
page one. Choose solid | : el ; 1]
Text Pict SR (e W R e
e menu.

o [P TRVLTESEE (T — T . -

H - . i
| - - H

B e PR e L LR e -
i . I

ReadySetGo has " & File Edit Create Font Style Format Block Page Special
created a default 11 L T E ‘ R A - 11]1‘
W R ?

|

|
text block. The '

T |

default text block is | Lt L | |

T IR IE e T L LT e L L e e e e e e L e et e L

always a one inch i 1
square, pc:siﬁﬂned el v o S G S, O ARG P L
an inch downand | 2| W) e S T T T S R
an inch across from

thE‘ tﬂp lE‘ﬂ DI mE' ........ VRS R TR T A I| ................. ] ................ 1 RS L A e SRR v J .............. N
screen. Notice the v 7 oy ol RS RS WA SN 5y AR G '
outer rectangle. All o o S |
RO i i I *I il T ik AR « "H WA . .
are surrounded by %, L i AN Y S R WA S i . ...1]._*
a rectangular ..ﬂ 5 | 1
border to aid in

manipulating them and monitoring their status. This border will change
pattem from black to light gray whenever woik is begun on another
block. The border is provided as a user convenience and it does NOT
output on the printed page.
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Choose New York
from the Font
menu.

Choose Plain and
9@ Point from the

Style menu.
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2 Helvetica

Style Format Block Page Special
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Type the headline
"Beauty Fills
Chinese Exhibition
in Toronto's Royal
Museum"”. Notice
that it appears in
the font, size and
style chosen. The
blinking vertical
bar is called the
insertion point and
it determines where
the next character
typed will be
positioned. Notice
also that when the
pointer moves into
the text block, it
turns into an
[-beam. By position-
ing the I-beam in
the text and
clicking, the
position of the
insertion point may
be changed.

The text block can
be moved to any
other location on
the page by
positioning the
pointer directly
under its upper

& File Edit Create Font Sty

le Format Block Page Special

ﬂ ‘ 5 tREy ]iz 5 “ 5 6

1 | |
. 5 ST R v e e | i PR A -
_____________________________ Exhibitionin | | | .
Teronte's

Royal Huseurm| f |

2
T T ey g peoidgen ¢ O 3 RS 7Y + i 38 Lo aa Lty
0 R e

% ST TR 0 DO 59 SO TR SRANAD S U 5| S Vil S e =
: i
ﬂ i ; | ! I
. : | E : | i | i f i |

Edit Create Font Style Format Block Page Special

“
1 2 B a CI 6 |7
! '! ﬂ
| | E
...... I'_.._" —mreemn H“tr rilu o1 ) B Ii- T ---l----------—l[—ll L] - i o it 8 e i 8 8 e
i Chirese i
..................... Exhibitionin | |  ETE TSN T el DA
Teronte's |
Reyel Huseum St
7 IR L ey fio 2odicte ardl L
|
I . ; .............................. | N TR, ENEILE
.
i
S5 b WA G UKD SO | AR § RRCUT TR S i
I ke K Bt
................................. :-...-i < ol ,.....;...,,. : ...1.. A—— .ﬂ...l..
2 b ] i

border and dragging. A gray outline of the block will move around the
screen until the mouse button is released. ALL TYPES OF READYSETGO
BLOCKS MAY BE MOVED IN THIS MANNER. Try moving the text block to

the position shown.
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The size of ﬂ'lE " & File Edit Create Font Style Format Block Page Special

block can be ﬂ | SRR A iy 4 i ﬂ i
changed by | _—
positioning the i O
pointer in the i
lo“' ﬂg‘h‘t corner T Nk S e VRS SIS S ot T 'i ................ ___________ B T s, e e M £ £ P i
il ot | _ ‘mf":::.“‘i' AV EHL Ll < L 1
gray outline of the Exhibition in Ml
[ E-SiZEd bl o Ck Wﬂl ........ B B A e ] i E ....... :;:‘; l:“ml R SNy e, ETwg ................ s !
appear. When the $ bi-dlod o 1. | = | S T e BV 5o, e B |
mouse button is - |
released. the entie | —T+—1—1— R P W UG A

block will change "1] .............. e e e e 1R S CaTis s ¢ Tl ﬂ .

size. ALL TYPES OF
READYSETGO
BLOCKS MAY BE
RE-SIZED IN THIS
MANNER. Try
changing the size
of the text block as
shown above.

The screen should " & File _Edit Create Font Style Format Block Page Special . .1
look something like .i] B g jer T YT s | .y
this. Notice that the [y
line endings of the | | | MRS A SN R
okt Rrve: a1 T AR i : | |
to accommodate g AT LR - ;G s . et By S T e S Lot gt :
the new block 2| 11011 [Sewaty Fitts chinese Exhibition in Torentes Reyat | |
width. ’ E FE B s




Although the
mouse techniques
for moving and
re-sizing a block
are fast and

easy to use, it is
sometimes difficult
to achieve the
precision required
for exact and
detailed layouts.
Choose Modity
from the Block
menu for a more
precise method of
both moving and
re-sizing a block.

The screen should
now look some-
thing like this. The
first four boxes
contain the exact
position and size
(in inches) of the
text block. These
numbers can be
edited using the
mouse and
keyboard. Change
themtol 1, 65
and .85 inches
respectively and
click OK.
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Duplicate
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Notice that the text
block is now
accurately
repositioned and
1e-sized. Drag the
I-beam over the
text to select it.

Choose 24 Point
from the Style
menu.
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Notice that the
entire headline
increases in size
Click the mouse
somewhere else
in the block to
de-select the
sentence Choose
Show Page from
the Special menu.

Text blocks are
represented as
rectangles in the
show page
window. Drag the
grey rectangle until
it surrounds the text
block and then
click Close in the
File menu.
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The entire text
block is now

visible on the
screen. Choose
Center from the
Format menu to
automatically
center the headline
within the block.

Now choose Solid
from the Create
menu.

" & File Edit Create Font style |ETTEINYH

12

4

Block FPage Special

“left

Beauty Fills Chlne
Totonto s Royal Mt

&

Right |
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i
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A default solid " & nle Ldit_Create Font *.tuiﬂ rurmut Block Fuge Special -

block appears as a e
| inch square, r Beauly FlllS Chmese E:{hlbltlon in

positioned an inch | l antm s Royal Museu m\
doxar cond-an ineds | __ B A ——
across from the top
left of the screen.
The rectangular et
border which .
surrounds it serves Bt
(8. |

as the border WA TR R T A Y N R (R 7 D (P AN RS, S99 (VL G
which surrounded o NG T ) AR\ R s DN AN
T T IR TR G O
Notice that the
border of the text
block has turned to
gray, indicating
that the text block
1s no longer the
active block.

The solid block " & File tdit Create_ Font uqn Formot _Block Fuge Speﬂnl

may be moved R
and re-sized in r Be auty FlllS Chmese Exh1b1t1mn in

exactly the same Torﬁnto S Royal Museuml
manner as the text i. o S S i TR l
bolhieridirectis T T 1B |
border and drag N R Tk N0 U MRE O T G
the block towards o P 10 (kB
the center of the .l e ;i 1___ s SO (B, CHREES SOSHER L

screen. L) R 1

E B Ll Lathet IR =
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The screen should
now look something
like this.

Position the pointer
in the block's lower
right corner and
re-size the solid
block to make it
long and nAarrow.
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The screen should

now look something

like this. A vertical
line has been
created.

Choose Modity
from the Block

menu to accurately
position this line.
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Change the start
across and start
down to 425 and 2
inches respectively.
Leave the width
alone but make
the depth 8 inches.
Click OK.

Choose Solid from
the Create menu
again.
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Solid Block Specifi
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Re-size this new
solid block into a
horizontal line as
shown.

Choose Modify
from the Block
menu.
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Change the start
across and start
down to | and 102
inches respectively.
Change the width
to 6.5 inches and
leave the depth
alone. Click OK.

Notice that the new
solid block has
moved off-screen
since its start down
position is 102
inches. Scroll it

into view by
holding down the
Command key and
clicking in the
bottormm middle of
the screen. Do this
twice.
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Choose Display
Page from the
Special menu to
see d "mini-picture”
of the entire page.
Remove the
Display Page
feature by choosing
Close from the File
menu or clicking
in its go-away box.

Now choose Frame
from the Create
menu.
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The default frame " & File [dit Create Fant Style Formnt Block Page Special 3
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down and an inch
across from the top W T |
left of the screen. e SR T SRR T
Notice that both of NG AT |

the solid blocks (ie. W SN 9 T L
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The frame block is
surrounded by a
black border indi-
cating that it is
now the active

block.

Frame blocks may " & File 1di1 Create Font Style  Formnt Block Page Special
iy agsnatp 0 : 1]' - ; | ! " |* 5 - ,? 1]
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ReadySetGo blocks.
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side of the screen. o S . ]
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Re-size the frame " & _Fite tdit Create iont style Formnt Block Page Special
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Change the Start
Across and Start
Down boxes to 45
and 7 inches
respectively. Make
the frame 3 inches
wide and 3 inches
deep. Click OK.

The screen should
now look something
like this.
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Choose Picture " & File i
from the Create 1] P
mernu T

Font Style Format Block Page Special
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Choose Scrapbook
from the Apple
menu. The
ReadySetGo
program disk
contains a sample
scrapbook file for
use in this tutorial

Scroll the
Scrapbook to find
the picture of the
robot. Choose Copy
from the Edit menu
to place a copy of
this picture on the
Clipboard RRemove
the Scrapbook
from the screen by
clicking in its
go-away box.
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Choose Paste from " & File Create Font Sty Format Block Page Special s
the Edit menu. The 1] bndo EZ[5 T M PRl ﬂ
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More of the picture " & File Edit Create Font Style Formot Block Page Special
can be ExpOSEd bY ey T— :n: G -1 1{ ,: ii ... ~—. g :
increasing the size 71] i i i

of the block but
first position the
pointer immediately | %
undemeath the top
border and drag | |
the picture inside 5. IR i R E, ............. b I 1

!

the frame
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Re-size the picture " & File Edit Create Font Style Format Block Page Speciol 1

i ‘!n'-.u!- T T

block by position- ﬂ 18] T TS T 1 i |. 7 ﬂ -
the bottom right WARBEL R SNRUE) |
corner of the o e [T .-

dragging R e (RA )

A note of caution: ReadySetGo blocks are opaque on the
screen. If an inactive block is accidentally activated (by
clicking in it) it will cover whatever blocks it happens to
overlap. If this happens, choose Send Behind from the Special
menu to restore to active status the block being worked on
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When the mouse " & File Edit Create font Style Format Block Page Special
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Change the Start
Across and Start
Down to 47 and 7.2
inches respectively.
Make the picture
2.6 inches square
and click OK.

The screen should
now look some-
thing like this. The
picture itself can
scroll inside its
block. Imagine the
block with a
tic-tac-toe board
superposed on it.
A click in the top
middle scrolls the
picture up; a click
in the bottom left
scrolls the picture
down and to the
left, etc. Try scrolling
the picture inside
the block.
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Choose Display
Page from the

Special menu to
examine the
current "look” of
the page.

Remove the

Display Page
feature by clicking

in its go-away box.
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Choose Show Page
from the Special

back to the top of | _ . |
the page and then
remove Show Page. | ] LRI
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Choose 12 Point " & File Edit Create Font Style Format
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Now choose Text
Link from the
Create menu to
begin building a
ReadySetGo Text
Chain. A text chain
is nothing more
than a combination
of ReadySetGo text
blocks which have
the additional
property that their
contents are
"linked” together. If
the dimensions of
any or all of the
text blocks in a
chain are modified
the content may
be automatically
reflowed throughout
the chain.

A new link in a
text chain may be
inserted either
before or after the
current text block.
Click OK to create
a Text Link block
after the current
Text block.
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Choose Modity
from the Block
menu to accurately
manipulate this
Text Link block.
Change the Start
Across and Start
Down positions to
45 and 2 inches
respectively. Make
the block 3 inches
wide and 4.8 inches
deep. Click OK.

The screen should
now look something
like this. Choose
Show Page from

the Special menu
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Show Page
provides a fast
diagram of the
entire page. Notice
the two solid
blocks which
appedr as a
horizontal and a
vertical line; the
picture block
which appears as
an X" inside a
box; the frame
surrounding the
picture block; and

& Flla Fdit Create hmt $t|;l1 Formnt Hlmk FI[]I: Sprecind 7

fy | oy ‘4

EJ- untitled Fuga [ _I

:FE 7

| ke 4 - .. R a— ‘ : 1

1 Chmese Exhlbltmn n
) S Rﬂyai Museum

the three text blocks; the "headline” block across the top and the text
"chain” which begins in the left column and jumps to the right column.

Remove the Show Page feature by clicking in the go-away box.

Make the left
column the active
block by clicking
in it. Notice that its
border turns solid
black and that the
border of the block
that was previously
active turns gray.

Any ReadySetGo
block can be
made active (at
any time) by
clicking in it.
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Choose Get Text
from the File menu.
This selection is
available whenever
a Text or Text Link
block is active.

The screen should
now look something
like this. "ChinaTxt”
is the name of a
Text File supplied
on your RSG disk.
Select the text file
by clicking it once
Click Open io flow
the contents of the
file into the active
text block.
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The screen should

now look something

like this. Notice that
the text assumed
the font, style and
size of the insertion

point.

Use the [-beam
cursor to select the
first line of text.
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Increase the Size of
the selected text
from 12 Point {o

18 Point.

The screen should
now look something
like this. Choose
Reflow from the
Format menu to
flow the text
throughout the

Text Chain
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After a few seconds
the screen should
look like this. The
text file contained
more text than the
first block could
hold and the
Reflow command
took the excess text
and placed it into
the second block
in the chain.

Choose Display
Page from the

Special menu.
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The Display Page
feature shows the
"mini-picture” of
the entire page.
Remove it from the
screen by clicking
in its go-away box.

Hold down the
Command key
and click in the
lower right of the
screen to scroll the
bottom right of the
page into view. Do
this twice. The
screen should now
look something like
this. Notice that the
Text Link block
cannol display all
of the text that it
holds.
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ReadySetGo blocks may be thought of as "bottomless pits’
capable of holding more text than can be displayed. The
excess text can be made visible by a number of ReadySetGo
operations, such as increasing the width or depth of the block
or going to a smaller size If text is removed from the top of the

block (eg. by using Cut from the Edit menu) the balance of
the text will "bubble” to the top.




Make the second
link in the text
chain the active
block by clicking
in it. Notice that its
border changes
from light gray to
black. Choose Text
Link from the
Create menu
again to get
another text link to
accommodate the
extra text. Insert this
new link after the
current block.

The new Text Link
block is now the
third link in the text
chain. There is no
room on the first
page for this new
block. Choose
Move from the
Block menu.
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The screen should
now look something
like this. Enter a 2
and click OK to
move the third link
in the chain to the
second page.

The screen should
now look something
like this.
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Choose Modify
from the Block
menu to accurately
position this text
link on page two.

Change the Start
Across and Start
Down to 1 and 12
inches respectively.
Make the block 3
inches wide and
8.6 inches deep.
Click OK.
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ChooseShowPuga " & File Edit Create Font Style Format Block Page i
from the Special I |Ts .&

PUORCYD FON. " NS G SR L
menu. | S | send Behind

: Display Page
.| Display Facing Pages
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Scroll to the top left " & File tdif Create Font Stgle Format Hack Page Special s

of page 2. Remove S0)=== untitled Page 2 -. = ° B & ' 2 202, o M L E |
the Show Page i | S

Close from the File
menu.
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The first block in a
text chain must be
active for text to be
reflowed. Choose
First Block from
the Block menu

to make the

beginning of the
chain active,

After a few seconds
the screen should
look like this.
Notice that the
current page is
now one Choose
Reflow from the
Format menu.
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After a few seconds
the screen should
look like this. To
examine the
second page of the
document choose
Last Page from the
Page menu.

Notice that the text
now flows through
the three blocks of
the text chain. The
first two links of the
chain are on page
one and the last
link is on page two.
Choose Show Page
from the special
menu.
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works of art quite distinct from
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But it is equally true of objects

“1that are smaller and less

spectacular, like the stoneware
pillow of the Sung dynasty that
has upon it a picture of a baby

.| boy lishing. The concept of

pleasant dreams could hardly be
more deftly epitomized than in
this little piece

cannot say that this is much in

- evidence in the catalog that has

been produced for the Toronto

shoawnne and no donbt hears the

The Chinese have, as we know,
"|a great sense of fun, though I

Block Page )
| i
Hide Grid

Send Behind
Display Page
Display Facing Pages




Scroll o the bottom
of the text link
block and then
remove the Show
Page feature by
clicking in the
go-away box.

Notice that there is
still more text in the
third block than
can be displayed.
Choose Text Link
from the Create
menu to insert a
fourth link after the
current text link
block.
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Choose Modify
from the Block
menu to accurately
re-size and

re-position this new
Text Link

Change the Start
Across and Start
Down to 45 and 12
inches respectively
Make the block 3
inches wide and
8.6 inches deep.
Click OK.
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Again the first block
in a text chain must
be active for the
text to be reflowed.
Choose First Block
from the Block
menu to make the
beginning of the
chain active

Choose Reflow from
the Format menu.

i B

_______ i

File Edit Create Font Style Format

.Chinese are gifted mimics. If this @
'side of their national character is
| somewhat subdued in Toronto, it
' bursts out all the more strongly on

------- ithe rare occasions when foreigners |

|are portrayed. From the eighth |
i ce@Ntury AD. there are, for
instance, three painted pottery
_ifigures of horsemen: chesty

" |central Asians, all three of them,
| who were much in demand as L

‘household servants in the Chinese
capital A certain free-running

fionirae Af imaginary animale that |
bl [ e i - J

,__
LR
-
a

fancy may also be detected in the '

Last Block I

FPage Special
Modify XM
Clear

Duplicate
Delete

Move

Next Block
Previous Block

*

File Edit Create Font Style

...... 1l

1 12 3 vileft

Right

e

vSingle
1-1/2

- - Other
Chinese Exhibition

~-NOW ON View.
Exhibitionitis, though benign,
{contagious. It manifests itself in a

general state of euphoria, coupled
with the attribution of magical

powers to a visiting anthology of
works of art quite distinct from

Center
Justify

SEELTLE TIPS il

s e i i

the intrinsic quality of the objects,

Block Page Special

i

E 5 6 ﬂ 7
e Exhibition in
| Museum

TETTE I i R men o et | e T PRI 1 L T o B e ey

warmly received in Paris, Vier

|
'r
|

Uacuum |and Stockholm. China is still a

place of mystery to most of us
and there is undeneiably a
particular white magic about a
very beautiful object that has

- been buried beneath the grous

for 2,000 years or so. There ar

_imany such objects in the Chine¢

exhibition: and they have a



Choose Last Block
from the Block
menu.

The screen should
now look something
like this. Choose
Display Page from
the Special menu
to see a "mini-
picture” of page
two.
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The screen should

now look something

like this. Remove
the Display Page
feature and then
choose Show Page
from the Special
menu.

Scroll to the bottom
right of page 2.
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Remove the Show
Page feature from
the screen by click-
ing in its go-away
box. Activate the
far right block by
clicking in it. Notice
that its border turns
solid black. Position
the pointer in the
lower right corner
and decrease the
depth of the block

by dragging up.

The screen should
now look something
like this. Choose
Solid from the
Create menu
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Choose Duplicate
from the Block
menu three times
to create a total of
four solid blocks.

The screen should
now look something
like this. Position the
pointer in the lower
right corner of
each solid block in
turn and transform
them into three
horizontal lines
and one vertical
line
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Use the Modify
choice for each of
the four solid blocks
in turn and give
them the following

properties:

Start  Start

Across Down Width Depth

Across Down Width Depth
Wzl 4 | 1 | es [0
""2"1 45 | 7 | 3 |.o13
H‘;'z 1 | 10 | 65 |.013
“f“ 425 | 12 | o138 | 8s

(all measurements in inches)

Choose Display
Page from the

Special menu.
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Choosing Modify will display the specification sheet belonging
to the active block, ie, the block with a black border To make
an inactive block active simply click in it
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The screen should

now look something

like this. Choose
Close from the File
menu to remove

the Display Page

from the screen.

Choose Text from
the Create menu
to start a new text
block. Notice that
by choosing Text
instead of Text Link
this new block is
independent of the
text chain.
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Position the pointer
directly under the
top border and
drag the new text
block under the
short horizontal
rule

Position the pointer
in the bottom right
of the text block
and drag to make
the block larger.
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Choose Geneva
from the Font menu
and Plain and 10
Point from the Style
menu.

Create a small
chart by typing the
following:

1. Hit the tab key.
2. Type “"Province”
3. Hit the tab key
4, Type
"Population”.
5. Hit return twice
6. Hit the tab key
7. Type "Anhwei".
8. Hit the tab key
9. Type
33,944,000
10. Hit return, etc.
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Keep going until the screen looks something like this. Select the first line of

the chart and choose Underline from the Style menu.



The two page
document is
finished. Choose
Display Page from
the Special menu
to examine the
overall look of each
page Remove the
Display Page
feature by clicking
in its go-away box.

After checking that
the printer is turned
on and connected
choose Print. . .
from the File menu.

r

& File Cdil Crente Fond

Style

Hlook

Formnt Page

it

:. (=== untitled Page 2 ==

1l worth attending

of
ew
its
rar
por
ury
ANC
res
ral

"N‘*

B T Ll T LT T T B~ T

r present regime in China it is

Spred il

33,941,000
25,590,000
14,844,000
15,213,000
49,249,000
49,273,000
36,615,000

seh
tal,
¥ 0

=

31,178,000
12,972,000
18,845,000
22,778,000
12,712,000

................................................................................

Style Format

trongly on !
foreigners |
eighth |
ury A o1

ance, three painted pottery
res of horsemen: chesty 1
ral Asians, all three of them, | |

were much in demand as uiil
sehold servants in the Chinese | |

tal A certain free-running

Block Page Special

T

| | the present regime in China it is

.. well worth attending.

| i I :
| i, i Lo

Erwi nce

Anhwel
Chekisng

- Fukien

- Heilungkiang
| Hanan

q Hopeh
Hunan
Hupeh
Kansu
Kiangai

Population

33,941,000
25,590,000
14,844,000
15,213,000
k9,249,000
49,273,000
36,615,000
31,178,000
12,972,000
18,845,000

Kiangsu 52,778,000
Yy may also be detected in the | Ciria 12'712 000
I K DB . .".'I"'I. WA e Wil (s Bea] il o1]) AR | LTI
v i g i i ! i i | i i

s o g s e s £ 2 e s
i =




Set the printer
specifications and
click OK to start the
printing process.

This is the entire
printed document.
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Before quitting
choose Save As. . .
from the File
menu to save the
document on disk.

Either Entire
Document or
Layout Only can
be selected. Saving
the layout only will
save the specifica-
tions (including text
linkage) of all
blocks but will lose
the content of all
text and picture
blocks. This feature
enables creation of
an inventory of
design templates
for future projects.
Choose Entire
Document and
click OK
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Change the
document name
from "untitled” to
"China Piece” and
click Save.

Choose @it from
the File menu {o
return to the Finder.
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Scrolling is a technique for moving around the
document ReadySetGo pages can be scrolled by
two methods. The first method of scrolling involves
the use of the Command key and the mouse.
Imagine the screen divided into the nine squares
of a tictac-toe game. To scroll the page down, hold
down the Command key and click the mouse in
the bottom center square; to scroll the page up and
to the right, hold down the Command key and
click the mouse in the upper right square, etc. The
center square is 'dead”.

A R B

Vd B LS

The second method of scrolling involves the Show
Page feature To bring another part of the current
page into view choose Show Page from the Special
menu. Every element on the page is presented in
schematic fashion together with a dotted rectangle
which indicates the portion of the page currently
visible on the screen. To bring a different part of the
page into view position the pointer inside this
dotted rectangle and drag it.

ED&SSs untitied Page | |




Scrolling
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To bring a different page into view choose either
First Page Last Page Next Page or Previous Page
from the Page rmenu.

To bring a different link in a text chain into view
choose either First Block, Last Block, Next Block or
Previous Block from the Block menu. This is a
convenient means of “scrolling” through a text
chain. If the requested text link is on a different
page the current page is automatically changed.

All ReadySetGo blocks are surrounded by a
rectangular border. This border is solid black if the
block is active or gray if the block is inactive. Only
an active ReadySetGo block can be moved. To
activate an inactive block simply position the
pointer anywhere within the block and click.

To move any ReadySetGo block with the mouse,
position the pointer anywhere immediately
underneath the top rectangular border and drag.
A gray rectangle will follow the pointer. When the
mouse button is released the entire block will move
to the last position of the gray rectangle.

time for all
good men

ReadySetGo blocks can also be moved via their
specification sheets. With the block in question
active choose Modify from the Block menu. The
block’s specification sheet will appear on the
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screen. Different types of ReadySetGo blocks have
different specification sheets but all sheets have in
common the fields Start Across, Start Down, Width
and Depth. The contents of these fields can be
edited with the mouse and keyboard. Upon clicking
OK the active block will move to the new Start
Across and Start Down position. These numbers are
in inches and are relative to the upper left hand
corner of the paper.

Solid Block Specifications

Start Across 5.5278 incthes

Start Down 8.083%3% inches

To move a ReadySetGo block from the current
page to a different page choose Move from the
Block menu. The active block will move to the
page entered in the dialog box. This page
becomes the current page.

To which page? 2

To move all the blocks on the current page by the
same distance either up, down, left, or right choose
Shift All from the Block menu.

Shift All Blocks

@ Left O Right O Up (O Down

By how much? 1 inches
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To re-size any ReadySetGo block with the mouse,
position the pointer immediately inside the block's
lower right cormner and drag. A gray rectangle of
the re-sized block will follow the pointer. When the
mouse button is released the entire block will re-size
to the last dimensions of the gray rectangle.

s i | i B ] s L s e— i i ErrEEEe s e ————

ReadySetGo blocks can also be re-sized via their
specification sheets. Choose Modify from the Block
menu to display the active block’s specification
sheet. Use the mouse and keyboadrd to edit the
Width and Depth of the block. These numbers are
in inches. Upon clicking OK the active block will
assume the new dimensions.

Frame Block Specifications

Start Across 1.2361 inches
Start Down 4.3055 inches
Width 1.0000 inches
Depth 1.0000 inches




Adding Pages
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ReadySetGo

Document

Next Page
Previous Page |
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Last Page
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Deleting Pages
from a

ReadySetGo
Document

Delete

Neut Page
Previous Page
First Page
Last Page

Go To Page

Pages can be added to a document by choosing
Insent from the Page menu. A page may be
inserted either before or after the curnrent page and
the other pages in the document will be
rearranged automatically. The newly created page
becomes the current page As an example, consider
a seven-page document with page 4 as the current
page. If a page is to be inserted before the current
page (ie page 4), the newly created page
becomes page 4 and what had been page 4 is
now page S etc.

I‘
Insert Blank Page

| Duplicate Current Page
‘

In addition, the new page can be either a blank
page or an exact duplicate of the current page. If
the page being duplicated contains links of a text
chain, the contents are duplicated but the linking
information is not.

Insert ATter Current Page

Insert Before Current Fage I

@ O @

O

Pages can be deleted from a ReadySetGo
document by choosing Delete from the Page menu.
After a page has been deleted the remaining page
numbers are automatically adjusted. For example,
if the third page of a five page document is
deleted, what had been page 4 becomes page 3
and what had been page 5 becomes page 4. The
document would then be four pages long.



Solid Blocks

Text
Frame

Picture l

Teut Link

73

Solid blocks are a means of displaying solid areas
of various shapes and patterns on the page. They
are particularly useful for the creation of lines and
bars. For example, a thin horizontal line may be
created by re-sizing a solid block to its minimum
depth or alternatively setting its depth to .0139 inch.
Likewise, for a vertical line by setting its width.

A hairline rule may be created by setting the
width or depth of a solid block to zero Such a rule
will appear as a one point rule on the Macintosh
screen and the ImageWriter printer, but will appear
as a true hairline rule on the LaserWriter.

In addition to the block’s position and dimensions,
the solid block specification sheet allows for the
selection of.

. The solid’s shape—either rectangular,

rectangular with round corners or oval; and
2. The solid’s pattern—either solid black, dark

gray, gray or light gray.

For example, the following settings yield a light
gray circle (oval), 2 inches in diameter:

Solid Block Specifications

Start Across 1 inches

Start Down 1 inches

Width 2 inches

Depth [2 inches
ol o °@®
oMl oMl oW oW |
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Frame blocks are a fast and efficient means of
putting borders around different elements of a
page. The frame block’s specification sheet allows
you to specity:
1. The frame's thickness in points (72 points equal
l inch);
2. The frame's shape—either rectangular,
rectangular with round corners, or oval,
3. The frame's pattern—either solid black, dark

gray, gray or light gray

For example, the following settings yield a 6 point
thick, gray oval:

Frame Block Specifications
Start Across | inches
Start Down 1 inches
Wwidth L1 inches
Depth 1 inches
Frame Thickness |§ points

O o). 0
O ol ol ol
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Text Editing Text editing with ReadySetGo involves either

with selecting an insertion point or selecting a range of
ReadySetGo text in the document and acting on it by typing or
choosing commands. All text editing is done in an
active text block.
To select the insertion point, click the [-beam
m pointer where you want to insert, remove or paste
frame something.
solid
Picture
Teut Link To select a range of text drag along a line of text in
either direction or drag across lines of text in any
direction.

To insert text simply select the insertion point and
type the new text Any text following the insertion
point moves to accommodate the new text

To remove text with the Cut command from the

— Edit menu, select the text to be removed and
w choose Cut. ReadySetGo places the text that was

Paste XU cut on the clipboard. It remains there until the next
'”’;I;";I"I"“' cut or copy

To remove text with the backspace key either
select the insertion point and press the backspace
key to remove characters one at a time, or select a
range of text by dragging and remove the entire
range by pressing the backspace key Note that
removing text with the backspace key does not
place the selection on the clipboard.
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Any text selected in a ReadySetGo document can
be replaced. Once a range of text has been
selected it may be replaced by either typing new
text or by choosing Paste from the Edit menu in
which case the contents of the clipboard replace
the selection range.

To move or copy text within a document, first select
what is to be moved or copied and then choose
Cut or Copy from the Edit menu. The selected text
is placed on the clipboard. It retains its own
combination of font, size and style. Next, select the
insertion point where you want to put the contents
of the clipboard. This insertion point may be in the
same text block or a different text block, either on
the same page or another page. Notice that a text
block must be active before an insertion point can
be selected in it. Finally, choose Paste from the Edit
menu. A copy of the contents of the clipboard
either appears at the insertion point or replaces
any other selected text.

To change the style or size of the text, first select
either the text to be changed or select the insertion
point and choose a style or size from the Style
menu.

To change the font, first select either the text to be
changed or select the insertion point, and choose a
font from the Font menu.

Now is the time
for DIEOCKs Bt
to come to the aid
of their country.

Now is the time
for all good men
to come to the aid
of their country




Justification
and
Line Spacing

Justify
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Reflow ]

Paragraph and
Left Indent

Justification refers to the horizontal placement of
the text with respect to the left and right margins of
the text block. The four choices are: Left, which
aligns the text with the left margin; Right, which
aligns the text with the right margin; Center, which
centers the text between the left and right margins;

and Justifty which aligns the text with both the left
and right margins.

Line spacing refers to the spacing between lines.
ReadySetGo allows the selection of either single,
12, double or variable spacing. To use variable
line spacing select Other from the Format menu. A
dialog will appear requesting a line spacing in
points (there are 72 points in an inch). All text which
appears in the active block, regardless of size, will
display with this number of points separating the
baseline of each line in the block. Sizes which are
larger than the line spacing will appear “clipped”
on the screen but output fine to the printer.

Note that different text blocks may have different
justification and line spacing, but that within a
particular text block the justification and line
spacing selected apply to the entire block. The
justification and/or line spacing of the active block
can be changed at any point in the working
session by selecting the appropriate item in the
Format menu.

The Text Block Specification sheet presented when
Modify is chosen while a text block is active
contains the fields Para Indent and Left Indent. The
Para Indent refers to the indentation of the first line
of each paragraph from the left margin. It is given
in inches from the left margin. The Left Indent refers
to the indentation from the left margin of all lines of
the paragraph other than the first. It also is given in
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inches from the left margin of the text block.

An alternative method of indenting paragraphs is
to use the tab key If no tabs are set the tab key
inserts a fixed space of 8 points independent of the
current size. This method of indentation must be
used for text chains to avoid an unwanted indent
when the first line of a text link comes from the
middle of a paragraph. Indents larger than 8 points
simply require hitting the tab key a few times.

Tables may be created within text blocks by setting
the tabs in the block’s specification sheet and then

using the Tab key ReadySetGo allows for up to five

tabs which may be either Left aligned or Decimal

aligned. A decimal tab lines up the text (usually a

number) at the decimal point position.

Tabs are activated and de-activated by clicking
their On button. All measurements are in inches
relative to the left margin of the text block.

After clicking OK, each row of the table can be
created by pressing the Tab key to move to the
next column and then typing the desired text. Press
Return to move to the beginning of the next line.

Tent Block Specifications

Stert Across |jp.2778 |in. Tabs

Start Down (4.4305 |[in. | On Left Dec. Inches

Width 64000 |in. | ® @& O |0.5000

Depth 38611 |in. | @ O @® [1.5000

Para Indent |popo0D |in. | @ @ O |3.0000

Left indent |p0000 |in. | ®@ O @ |4.5000
. ® ® O |s.5000
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Any picture or text saved in the Scrapbook can be
used with ReadySetGo. The Scrapbook is convenient
for keeping together a number of often used
paragraphs, illustrations, etc. While the clipboard

can only hold one item at a time, the Scrapbook
can hold many.

To copy text or pictures from the Scrapbook into
ReadySetGo, choose Scrapbook from the Apple
menu and then use the scroll bar to find the text or
picture you want. Choose Copy from the Edit menu
to place the text or picture selected on the

clipboard. It will remain on the clipboard until the
next cut or copy.

(=== q(raphook e |

A picture can be created in MacPaint and then
inserted into a ReadySetGo document. To do this
start with MacPaint and select and then cut or copy
the picture. This places it on the clipboard. The
clipboard is a temporary holding place for
whatever was last cut or copied. After this, quit
MacPaint and return to the finder. Open the desired
ReadySetGo document and create a picture block
and move it to the page and position required.
Then choose Paste from the Edit menu. The
contents of the clipboard then appear in the
picture window.
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With ReadySetGo the contents of a picture block
may be "cropped” and "scaled”

When a picture is pasted into an empty picture
block, it displays in the same size it was created
and with its upper left cormner coinciding with the
upper left cormner of the picture block.

After the picture is pasted in, more or less of it can
be exposed by re-sizing the picture block.

Different parts of the picture can be brought into
view by repeated clicking in various parts of the
picture Think of each rectangular picture block as
being mentally divided into the nine squares of a
tic-tac-toe game. The center square is dead but
clicking in any of the other eight will move the
picture in the direction indicated.

N g iy
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Manipulating
a ReadySetGo

Picture
(continued)

Duplicate
Delete

Maove

Shirt Al

Neut Block
Previous Block
First Block
Last Block

To scale a picture, choose Modify from the Block
menu and with the mouse and keyboard edit the
Scale Across and Scale Down fields. For example, to
double the size of a picture, make these both 200
percent. Note that scaling a picture may introduce
some distortions.

|| Picture Block Specifications

Start Across 0.4028 inches
Start Down 4.0555 inches
Width 5.0072 inches
Depth 3.6528 inches
Scale Across 200 percent
Scale Down 200 percent

l.- i
A L B 8
e B lr_|| A

"-.r

ar N s
‘*’ f- J# I:f};* J:ET'-F“}: F‘ e I . x
:) ie] a iﬁ‘r
. , ' Il |- E) e
':?".':' e _'3 oA NG ,-"::':'_'-'_' GE A

8l



Text Chains,
Text Links,
Vacuum and
Reflow

Tent
Frame
Solid
Picture

Modify ®M
Cleay

Duplicate
Delete

Shirt Al l

............................................

Neut Biock
Frevious Biock
First Blodk
Last Hlodk

Modify M
Clear
Duplicate
Delete

Move

Shift Al

Next Block
Previous Block

82

ReadySetGo allows for the creation of any number
of Text Chains throughout a document.

Any text block created by choosing Text from the
Create menu can serve as the first link in a text
chain. Links can be added to the text chain by
choosing Text Link from the Create menu. This
action will insert a text block into the chain either
before or after the current text block

|‘ @ Insert After Current Block

(> Insert Before Current Block

o

Text chains can be made to span pages in a
document by choosing Text Link to create another
block in the chain and then choosing Move from
the Block menu to move this link to another page.
The sequence of links in a text chain has nothing
whatsoever to do with the sequence of pages in a
document For example, a text chain can start on
page 13 and end on page 6.

e e—

To which page? 2

| —— —

First Block Last Block Next Block and Previous
Block are useful in scrolling or stepping through a
text chain.

If a text link in the middle of a chain is deleted, the
chain automatically adjusts itself to "seal” the
break.
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Once a text chain is created, each individual link
behaves as a normal text block. It can be re-sized
and moved, its tabs can be set and then changed,
text can be inserted and formatted, etc. The only
two commands that act on the chain as a whole
are Vacuum and Reflow in the Format menu.

For either Vacuum or Reflow to work, the first link in
the text chain must be active. If the first link in the
chain is not currently active, choose First Block in
the Block menu.

Vacuum takes all the text in the entire chain and

“vacuums” it back into the first block. This is useful
if the links of a text chain need to be rearranged

without being concerned with their contents.

Reflow takes all the text in the entire chain and
"reflows” it through the chain. This is particularly
useful if a large amount of text is brought into the
first link in the text chain from disk by choosing Get
Text from the File menu.

Many Macintosh applications have the ability to
produce a “text” file on disk. MacWrite is probably
the most common example of such an application.
When saving a MacWrite document to disk the
user is given the choice of saving the document in
its entirety or as text only A MacWrite document
saved as text only loses all of its formatting and
retains only its text. ReadySetGo is capable of
reading such a text file from disk. To do this, choose
Get Text from the File menu with a ReadySetGo
text block active The entire contents of the text file
will be inserted in the text block at the insertion
point with the font, style, and size associated with
the insertion point.
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ReadySetGo
Page Size and
Orientation
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Bpen

Close

Save |

Save As...

Print...

Get Text

Quit

The size and orientation of the pages in a
ReadySetGo document can be adjusted by
choosing Page Setup from the File menu. The
content of the dialog box which appears depends
upon which printer is installed on the disk.
ImageWriter drivers show this dialog:

|| Paper: @ US Letter O A4 Letter
O us Legal O International Fanfold
Drientation: O Tall @® Tall Ad justed O Wide '

and LaserWriter drivers this dialog:

LaserlWriter

Paper: ® US Letter O A4 Letter Reduce or -
O US Legal O BS Letter Enlarge:
Orientation: @ Portrait O Landscape

—

(<] Font Substitution?

[ Smoothing?

With the ImageWriter, always use either Tall
Adjusted or Wide, never Tall.

US. Letter is 8% inches wide and 1l inches tall, while
US. Legal is 8%2 inches wide and 14 inches tall. The
wide or landscape orientation allows elements to
be placed across the 1l or 14 inches and down the
8%z inches.
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In general Macintosh printers, due to their particular
mechanics, cannot print near the top, bottom, left or
right of the sheet of paper Just how close they can
go to the edges depends on the particular printer
in use. Once a page size, eg. US Letter, is chosen,
ReadySetGo determines, given the current printer
installed, the part of the page the printer can put an
image on and draws on both the screen and the
Show Page display a solid rectangle representing
the “live” part of the page. Any ReadySetGo block
overlapping or outside this rectangle will print either
partially or not at all

untitied Page 1

To print the document, choose Print from the File
menu. A dialog box appears which allows for the
setting of the print specifications. After setting them,
click OK. To stop printing, hold down the Command
key and press the period key

Quality: O High @® Standard O Draft “
Page Range: @ Al O From: i| To:

Copies: 1
Paper Feed: @ Continuous O Cut Sheet

LaserlWriter
Eupln: Pages: @ Al O From: To: '
Paper Source: @@ Paper Cassette (O Manual Feed Coencel |
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Work should be saved often in order to keep a
current version of the document on the disk in case
you lose information on the Macintosh.

Choose Save from the File menu to write the
document to disk. The Close and @uit commands
in the File menu also allow the opportunity to save
changes to a document. Choose Save As. .. from
the File menu to either change the name of a
document or save it to another disk.

Unless a document is being saved for the first time,
no dialog box appears upon choosing Save.

ReadySetGo allows for documents to be saved in
their entirety or their layout only If layout only is
chosen, the contents of all text and picture blocks
are not written to disk. Use this feature with caution.

Do you want to save the entire document Il
or only the layout?

@ Entire Document [ 0K . ]

O Leayout Only [ Cancel |

To save a document to another disk, either click
Eject in the dialog box and insert the other disk, or
insert a disk in the external drive and click Drive in
the dialog box.

Do you want to save the entire document
0

Save this document as: . paint

L CI—

[ Save ) ( Cencer ) | Drive )




Opening a A new or existing ReadySetGo document can be
New or Existing | opened without returning to the Finder by using the

ReadySetGo File menu.

Document Close the existing ReadySetGo document by

choosing Close from the Flle menu. If the document
has changed, a dialog box appears that allows for
saving the changes to disk.

[lnse
Save
Save fls...
Poge Setup
Prink...

et Teut
Quit

Then choose either New or Open from the File
menu. New creates a new ReadySetGo document
and displays the upper left part of page |. Open
displays a dialog box showing all the ReadySetGo
documents on the disk. To open one, click it once
and then choose Open. Eject or Drive allow you to
open a ReadySetGo document on another disk.

untitlied K
Open | paint
L Ejest |
[ Cancel | | [ Drive |
&
Quitting To leave ReadySetGo, choose @it from the File
ReadySetGo menu. The dialog box allows for the saving of any

changes made to the document

New I

Dpen

Close

Save

Save RAs...
Page Setup

Print...
bet Teunt
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Text “Running
Around”
Graphics

ReadySetGo allows for the solution of the common
“text runaround” problem encountered in numerous
page designs. The basic idea is to create a text
chain in which the links conform to the contours of
the runaround. In order for the text to appear to
continuously flow from one link to the next, the top
of each text link should abut the bottom of the link
that precedes it in the chain. The depth of each
text link block should be an exact multiple of the
line spacing for that block. (Use variable line
spacing and remember that there are 72 points to
an inch.)

To take full advantage of the Reflow command,
layout the runaround with empty Text Link blocks.
Create a temporary text block in which to create
and edit the copy. Cut the copy to the clipboard
and then Paste it into the first link of the chain.
Upon choosing Reflow, the text will unaround the
graphic.

Bl s st A IR
Now is the time for all '
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Shadow A Frame and two Solid blocks can be used to
chkgrgunds create a shadow background. Create a frame with
the required thickness and dimensions. Create two
solids and use their specification sheets to position
them underneath and to the left or right of the
frame. By varying the solids’ positions and
dimensions, various effects can be realized.

Start  Stan
Across Down Width Depth

Frame 1 1 3 2

— e e

Solid 1 4 125 | .25 2

Solid 2 | 1.25 3 3 25

e o

(all measurements in inches)
(frame thickness = 1 point)

89



Reverse Type ReadySetGo allows for the setting of white letters on
a black or gray background. First create a solid
block with the position, dimensions, and
background pattern required. Then create a text
block and keyboard and format the material to be
set in reverse For best results the text should always
be bold. After the text is fully formatted, select all of
it, choose Outline from the Style menu, and position
the text block on top of the solid block. The text
block is opaque on the screen but the outline type
will appear reversed on both Display Page and
the printed output.

F b |

% File Edit Create Font Style Format Block Page Special

| 11 ' |2 3 ; 4 'S 6 ' 7
i i f : i i i i

E ' I ; i | ; | ' I ﬂ
o R e ke H . P LT
| | | | |

White type om &
black backgroumdl

o1
White type on a
black background!
Fonts ReadySetGo comes with a set of fonts installed.

These fonts may be removed and/or others added
using the font mowver utility ReadySetGo
cautomatically displays and makes available
whichever fonts are resident in the System Folder.

Q0



LaserWriter

Switcher

Limits

Product
Support

Backups

9l

ReadySetGo comes with the ImageWriter driver
installed. To use ReadySetGo with the LaserWriter
follow the “laser installation” procedure described
in the LaserWriter documentation.

ReadySetGo requires a 512K Macintosh. It will,
though, work with Switcher providing you configure
ReadySetGo with at least 256K.

The following limits apply to a ReadySetGo
document:

Maximum number of pages: 40 (Subject to memory
limitations)

Maximum number of blocks per page: 100

Maximum number of blocks per document: 1000

Maximum number of characters in a text block: 30K

Maximum number of characters in a text chain: 30K

Product support is available from | pm to § pm
(Eastern Standard Time) Monday through Friday.
The telephone number is: 212-691-9114. In order to use
our product support service you must be a
registered owner

The ReadySetGo disk is NOT copy protected. Before
you begin work use the Finder to make a backup
copy of ReadySetGo



Shortcuts File Menu

New: Command N
Open: Command O
Close: Command W
Save: Command S
Quit: Command Q

Edit Menu

Cut: Command X
Copy: Command C
Paste: Command V
Select All: Command A

Style Menu

Plain: Command P
Bold: Command B
[talic: Command |
Undeiline: Command U

Block Menu

Modity: Command M

Page Menu

Go To Page: Command G

Special Menu

Display Page: Command D

Scrolling

Command Click in appropriate screen zone:
A L8 i1
TR

92
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Apple Menu

File Menu

@4

This menu provides access to the desk accessories.
These are fully described in the owner's guide. One
particular desk accessory—Key Caps—is very useful
in conjunction with ReadySetGo. It provides the
keyboard layout of the complete set of foreign and
special characters available with the Option Key.
Characters such as single and double directional
quotes and en- and em-dashes are particularly
useful in creating documents with a professional
appearance. Note that not all special characters
are available in every Font

New — This command opens a new, untitled, one
page ReadySetGo document. The New command
is dimmed when a document is already open.

Open — This command opens a specified
ReadySetGo document on the disk. A list of current
ReadySetGo documents appears in a dialog box.
The eject and/or drive button allows for the opening
of a ReadySetGo document on another disk. The
Open command is dimmed when a document is
already open.

Close — This command closes a variety of things. If
Show Page is active, it closes Show Page. If Display
Page is active, it closes Display Page If Display
Facing Pages is active, it closes Display Facing
Pages. If a desk accessory is active, it closes the
desk accessory. Otherwise, it closes the ReadySetGo
document.

Save — This command saves the current
ReadySetGo document to disk, replacing in the
process any old versions which exist. A dialog box
appears the first time an untitled document is saved.




File Menu Save As — This command saves the ReadySetGo
(continued) document to another name and/or disk.

Page SetUp — This command allows for the specifi-
cation of the size and orientation of the pages of a
ReadySetGo document. The choices available are
determined by the printer file in the system folder.

Print — This command produces a printed copy of
the current ReadySetGo document using the
specified settings. Printing may be canceled by
holding down the Command key and pressing the
period key.

Get Text — This command opens and reads a text
file from disk into a ReadySetGo text block.

Quit — This command leaves ReadySetGo and
returns to the Finder.

Edit Menu Undo — This command is currently supported only
for the desk accessories. When a desk accessory is
active, it undoes the result of the most recent action.

Cut — If a desk accessory or a text block is active,
this command removes the selection and places it
on the Clipboard, replacing the previous contents
of the Clipboard, if any If any other type of block is
active, it does nothing.

Copy — If a desk accessory or a text block is active,.
this command places a copy of the selection on

the Clipboard, replacing the previous contents of
the Clipboard, if any lf any other type of block is
active, it does nothing.

@5



Edit Menu
(confinued)

Create Menu

Font Menu
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Paste — This command puts a copy of the contents
of the Clipboard at the insertion point of either a
desk accessory or a text block. If a picture block is
active and the Clipboard contains a picture, a copy
of the picture is put into the picture block.

Select All — If a text block is active, this command
selects the entire contents of the block, including
text that is not visible

Text — This command creates a default text block
and initializes its specification sheet.

Frame —This command creates a default frame
block and initializes its specification sheet.

Solid — This command creates a default solid block
and initializes its specification sheet.

Picture — This command creates a default picture
block and initializes its specification sheet.

Text Link — This command is only available when
a text or text link block is active It creates a default
text link block, initializes its specification sheet, and
inserts the text link block either before or after the
current block.

This command allows the choice of any available
font for the currently selected text or for text to be
typed at the insertion point. The font chosen is
checked on the menu. If all the characters in the
current selection are in the same font, that font is
checked on the menu; otherwise, no font is
checked. Fonts may be loaded or removed with
the Font Mover Utility.




Style Menu

Format Menu
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The top part of this menu allows the choice of the
style for the currently selected text or for the text to
be typed at the insertion point. The style chosen is
checked on the menu. If all the characters in the
current selection are in the same style, that style is
checked on the menu; otherwise, no style is
checked.

The bottom part of this menu allows the choice of
the size for the currently selected text or for the text
to be typed at the insertion point. The size chosen is
checked on the menu. If all the characters in the
current selection are in the same size, that size is
checked on the menu; otherwise no size is checked.
If Other is chosen, any size (1 - 99) may be selected.
For best screen results, use sizes that are multiples of
the font masters in the systemn folder. Sizes which
correspond to the font masters in the system folder
are displayed in outline.

The top part of this menu allows the choice of
horizontal alignment for the active text block. The
current type of horizontal alignment (left, right,
center, or justify) is checked.

The middle part of this menu allows the choice of
line spacing for the active text block. The curmrent
type of line spacing (single, 1'2, double, or variable)
is checked.

The bottom part of this menu allows the vacuum or
reflow commands to be invoked for the active text
chain.



Block Menu
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Modifty — This command displays the specification
sheet of the currently active ReadySetGo block.

Clear — If a text or picture block is active, this
command, after a suitable warning, clears the

" entire contents of the block. All block specifications

remain unchanged.

Duplicate — This command creates an exact
duplicate of the current block offset a bit down and
to the right of the original block. The newly created
block becomes the active block. If the newly
created block was a link in a text chain, the
original block remains a link but the new block is
not part of the chain.

Delete — This command, after a suitable warning,
deletes an entire ReadySetGo block—both contents
and structure,

Move — This command moves the active
ReadySetGo block to a different page. The page to
which it is moved becomes the current page.

Shift All — This command shifts all the blocks en
the current page by the specified distance (in
inches) either up, down, left or right.

Next Block, etc. — These commands allow for
“scrolling” through a text chain.




Page Menu

Special Menu
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Insert — This command allows for the creation of a
new page in the document The new page can be
either blank or a duplicate of the current page. In
addition, the new page can be inserted either
before or after the cunrent page. The page order of
the entire document adjusts itself automatically.

Delete — This command allows for the deletion of
a page in the document. After the deletion, the
page order of the entire document adjusts itself
cautomatically

Next Page, etc. — These commands allow for
“scrolling” through the pages of a ReadySetGo
document. The Go To Page command gives
immediate direct access to any page in the
document.

Show Page — This command displays a scaled-
down version of the current page in its own
window. Text blocks (empty or full) appear as
rectangles and pictures appear as Xrectangles. The
dotted rectangle on the page represents the portion
of the page visible on the screen. By dragging this
screen rectangle, another part of the page may be
brought into view. The Show Page window may be
left on the screen while working on the page. In this
case, its contents will be constantly updated as
work on the page progresses.

Hide Grid/Show Grid — This command toggles
between its two states. If Hide Grid is chosen, the
grid and ruler disappear Show Grid makes them

re-appedtr.



Special Menu
(continued)

Send Behind — If ReadySetGo blocks overlap, a
covered block may be brought to the front by
clicking in its content region. This action also makes
the block the active one However, it is possible that
a block may be completely covered by another
and thus provide no chance to make it active. If this
happens, choose Send Behind. It sends the currently
active block behind all others and activates and
displays the next block on the list.

Display Page — This command displays a scaled-
down “mini-picture” of the current page. The display
is for previewing only and it cannot be modified.

Display Facing Pages — This commmand displays a
scaled-down “mini-picture” of the current page and
the page which faces it. For example, if page 3 is
the current page, Display Facing Pages shows a
“mini-picture” of page 2 on the left and page 3 on
the right If page 4 is the current page, Display
Facing Pages shows a “mini-picture” of page 4 on
the left and page 5 on the right. The first page of
the document has no facing page If the last page
of the document is even, it has no facing page.

100
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Apple Menu 94
Backups 91

Clear Block 98
Clipboard 28
Close 94

Delete Block 98
Delete Page 72, 99

Display Facing Pages 100
Display Page 23, 100
Duplicate Block 57, 98

File Menu 94
First Block 69
First Page 69
Font 10, 90, 96

Frame Block 23, 74, 96

Get Text 39, 83, 95
Hairline Rule 73
Insert Page 8, 72, 99
Justification 77

LaserWriter 84, 85, 91
Last Block 69

Last Page 69

Left Indent 77

Limits @1

Line Spacing 77

MacPaint 79
Modify 13, 69, 71
Move 45, 70, 98
Moving Blocks 70

New @4
Next Block 69
Next Page 69

Open 87, 94

Page Orientation 84
Page Setup 5, 84, 95
Page Size 84, 85
Paragraph Indent 77
Picture Block 27, 80, 96
Previous Block 69
Previous Page 69

Print &3, 85, 95

Quit 66, 95

Reflow 42, 82
Re-sizing Blocks 71
Reverse Type 90
Runarounds 88

Save 86, 94

Save As.. 65, 86, 94
Scrapbook 28, 79
Scrolling 6, 7. 68
Select All 96

Send Behind 30, 100
Shadow Backgrounds 89
Shift All 70, 98
Shortcuts 92

Show Page 6, 68
Solid Block 16, 73, 96
Style 10, 76, 97
Support 9l

Switcher 91

Tabs 61, 78

Text Block @, 75, 96
Text Chain 36, 82
Text Editing 75
Text Link 36, 82, 96

Vacuum 83
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